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Overview

This document will walk you through the DTS2 interface, describing each major section and cover where
features and services may be found. The information presented here assumes that you have already
installed, registered and logged into DTS2. For information on installing DTS2, please see the Getting
Started: Installing DTS2 how-to guide on the DataTrace University home page. Service guides and

elearning are also available on the University page.

Additionally, your company may have setup specific settings that will affect how the search and reports
function and display. Please check the Profile Menu > User Profile option for information on your
company settings

DTS2 is highly customizable and the services and features shown my not directly correspond to your
company’s contracted setup.
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Application window
The DTS2 application window can be separated into seven areas.

S s T e

File View Profie Help \‘2
[ -3 - v | - |State CA - |County ALAMEDA - |Company STS PROD: STS 1 Go Cancel County Cumency [E} ARE Map (7] \i

SERVICES 4 ~ B - .
e —— A Phone: 800.221.2056 Email: Client Services tle Plant Coverage Blog

TITLE SERVICES

T) Subdivided

B) Arbs

8) Title By Add: Parcel

i R ) FEATURED DATA

E] Grantor/Grantee .

A Data /" Trace TRACE UNIVERSITY

P) Plat List \_‘ﬁ_’

) Broparty axes - COURSES

S;Jgi':ﬁf:}?gﬁﬁ WELCOM E TO DATA TR'ACE + County Specifics for Placer

N} Notary Public

TIPS SERVICES California

) TIPS,

HISEELLANEOUS SERVICES DATA TRACE EXPANDS FEDERAL BANKRUPTCY ,

D) Datedovn » DTS2 County Specifics

7) Batch Datedown
F) Fallout DATA Stanislaus California
H) Batch Imaging

Z) Completed Searches
©) Display/Maintain Order
W) Close/Cancal Order

DTS2 County Specifics El
Dorado California

How to Read a Title Chain
HISTORY > 5

Tax Services - Southern

DATA TRACE EXPANDS FEDERAL BANKRUPTCY DATA Cotfornia Broperty Taxes
JUNE 2016 Broad Search Functionality

» County Specifics for Hawaii
Read More About Data Trace EXPANDS Federal Bankruptcy Data
Title Integrated Property

Service (TIPS

Auto Chain Functionality

NEW DTS2 ENHANCEMENTS FOR MAY 2016
":'c . i‘-‘\‘ . "_’f

+ History Panel Updates

View all University
Courses i

l - n 3 -

[ ID:wa70

Title Bar

Menu Bar

Tool Bar

Services Panel
History Panel
Multi-function panel
Status Bar

NouhkwNRE

Title Bar
The Title Bar includes the count and state currently selected. Standard Microsoft Windows controls are

also included (minimize, maximize, close).

DataTrace 3 How To Guide



Menu Bar

The menu bar contains four options: File, View, Profile and Help.

File Menu

File | View Profile Help

Archive

Browse Archive

Pririt... Shift+F5
Prirt Preview... Alt+F5

Bxport Shift+F7

Email Shift+F3
Unregister Shift+F4
Logoff Cid+F4
¥ Edt Mt+F4

ILF>SERVILES

Print Menu Option (File > Print):

Print and Print Preview: See below for Print options.

Export: Generates the report or images in PDF or TIF. See

below for additional information.

Archive: Allow users to export a report to a central location on

DataTrace’s servers for later retrieval. This assists Client

Services in quick retrieval on behalf of a client.

Browse Archive: No longer used

Email: Attaches the reports or images as a PDF to an email. See

following screenshots for additional information.

Unregister: Removes the systems’ login. Requires a restart.

Exit and Logoff.

There are several additional options that allow you to print one or more reports or documents and

provide formatting for the images.

) Current Report ltem
) Selected Reports

Printer

(%) Use Default Printer () Select Printer

Name |CaroniRE570 PCL6

Status:  Other

Type:  Canon iR5570/iRE570 PCLE
Where:  172.17.61.252_2

Comment:

Preview

r N
3y Print - S ﬁ
Report Oplions Image Options
) Mo Reports ) No Images [ Show Header [J Show Footer
) Report Group ) All Images [ Override page limit O Show Annotation

*) Selected Images

Comment

This information will be used for routing purposes

anly.

Image Range Help

If wou enter multiple pages, use commas like this: 1, 4, 610, -2, -1

MNegative numbers indicate pages starting from the end of the document. For example ™
17 is the last page, ™-2" the second-to-last page, and so on. The document page limit can

be overriden by specifying the page range.

ok | | Cancel

DataTrace
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Export Menu Options (File > Export):
Similar to the Print menu option, the Export option will create PDF or TIF files and allow you to generate
one or more reports or documents into specific locations.

3y Export uz‘

— Report Oplions 1 Options
{73 No Reports ) No Images [ Show Header [0 Show Footer
| |
) Report Group () All Images [ Override page limit [ Show Annotation
) Current Report ltem {*) Selected Images =28 arv L
1 Selected Reports it e ErTeT
[] Portion of Current Page (Zoom)  This information will be used for routing purposes
| anly.
—Export As

) Individuzl Report and Image

{1 All Reports in one PDF ) Individual PDF Report(s) ) Pages |
() All Reports in one TIF () Individual TIF Report(s)

Export Report Location
|C:\U5ersh w'\Documents\DTS2 || Change |

1 Range Help
If wou enter multiple pages, use commas like this: 1, 4, 6-10, -2, -1
) All Images in one PDF (3 Individual POF Imagels) Negative numbers indicate pages starting from the end of the document. For example ™

- - 17 is the last page, ™-2° the second-to-last page, and so on. The document page limit can
() AllImages inone TIF {3 Individual TIF Image(s) e T )

Export Image Location
[C:\Users'\a 7 \Documents\DTS2 || Change |

73 All Reports and Images in one PDF

Export Report and Image Location
|C AUsers'y “Documents DTS2 Change

3 All Reports and Images in one TIF

Export Report and Image Location
|C:"-.L|sers"-{ ‘Documents' DTS2 Change

L S

This screenshot is an example only. Make sure to contact your IT or Desktop Support team to confirm

the default export folder locations.
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Email Menu Options (File > Email):
Similar to the Print menu option, select the reports or images to generate as single or multiple PDFs and
attach them to an email.

@ Email =I
— Report Oplions i
o Reports r ooter
73 Mo R [ Show Heade: [ Show F
eport Group vernide page limit Show Annotation
=R G [ Override limi O
(71 Current Report ltem [ Image Summary List
(7 Selected Reports ErreTh
| [w] Portion of Current Page (Zoom)  This information will be used for routing purposes
i anly.
—Email Opticns
=) Al
(") Pages: |
& All Reports inone POF " Individual PDF Reportis)
~ Image Range Help

& Al Images inone PDF ¢ Individual PDF Image(s) If you enter multiple pages, use commas like this: 1, 4, 6-10, -2, -1

MNegative numbers indicate pages starting from the end of the document. For example ™
17 is the last page, ™-2” the second-to-last page, and so on. The document page limit can I
be overriden by specifying the page range.

i [ ok ||Canoel|

Contact your IT or Desktop Support team for help in configuring DTS2 with your email client.
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View Menu
The View Menu deals with resizing or the display of the Services and History Panel, shown at right.

View | Profile Help
Services/History Panel  F&

! Maimize Service Panel

Services/History Panel: Will SERVICES

H TITLE SERVICES
show or hide the left hand panel 1) Subdivided

. . . b
of the DTS2 application window. | &) 2055 acrence

PRT U} Ranchos
Hldlng these panels allows 8) Title By Address/Parcel

G) General Name

displaying a larger Application E) Grantor/Grantee
. I} Instrument
Window. R) Reference

P} Plat List

TAX SERVICES

Maximize Service Panel: X) Property Taxes
BUSINESS SERVICES

Extends the Services panel to B
) Notary Public
TIPS SERVICES
1) TIPS
MISCELLANEOUS SERVICES
the other panels. D) Datedown
7) Batch Datedown
.. . . i X F) Fallout
Maximize History Panel: Extends the History panel to maximum height H) Batch Imaging
Z) Completed Searches
and collapses all other panels. 0) Display/Maintain Order
W) Close/Cancal Order

Maximize History Panel 2
Maxdmize Court Panel
Show/Hide Images Panel

Evenly Space Panels

|
[ Separate Image Window

Heference

maximum height and collapses

Maximize Court Panel: Disabled and no longer used HISTORY

& CA, CONTRA COSTA, STS (062
Show/Hide Images Panel: Disabled and no longer used. Investigative (12:56 PM 6/20)

@[ |L:38 B:M136 P27

Evenly Space Panels: Just like it sounds.

Separate Image Window: Creates a separate window to display images.
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Profile Menu

User Profile
Profile | Help Despite the name, the User Profile shows your company’s search
User Profile defaults for both Investigative and Order Options. These are your

P company’s’ default settings controlling how data is displayed. Change

these at your own risk.

A few additional notes about these setting:

1. Modification to these settings applies only to the immediate search you are running. Changing
searches, counties, or logging out of DTS2 will revert the settings back to the company defaults.

2. The settings are county-specific. Not all settings shown apply to every county.

Global Services - Global Options:

User Profile

GLOBAL_SERVICES Investigative Dptions
Global Options

TITLE SERVICES Printad Repaorts
Subdivided Dietail L 1
Arb

Sectional Datedown, Fallout, Order History
Reference
Name Search Results

TAX SERVICES ITEX. Title| » 2
Property Taxes

IMAGING _
SERVICES LSS

Imaging Options Printed Reports
Detail o 3 Keep Open Beyond 20 Days
~ il gl sl gyl

1 & 3. Printed Reports and Order Options: These simply control the report format — either Detail or
Condensed. The checkbox in the Order Options section allows you to keep orders open past 30 days.

2. Datedown, Fallout, Order History: Controls if Title and/or Tax services are affected by the Datedown
and Fallout services.
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Title Services:

These settings are county dependent and will not show for all counties. Each Title Service will contain

two panels: Investigative Options and Order Options. A summary of the options is followed by
screenshots.

Example: The Arb profile settings for a given county also show in the report for the Arb investigative

search.

Usar Profile

GLOBAL_SERVICES
Global Options

Investigative Options

TITLE SERVICES

Search Auta Chain

Extended Name b

SE
Fpd DISPLAY AUTO CHAIN

EXTENDED NAMES - 2

Subdivided IDispIsy ﬂ 9
Arb

Sagtinnal

R=1|ARB

Na

'Il:;h 30161125

1;10 SEARCH: FROM 00/00/0000 THROUGH 99/99/9999

1

ARB

PARAMETER ENTERED:

Options Summary:

Investigation Options:

Search Auto Chain:

Overlapping Property:
Extended Name:

Sort:

Consolidated Legal:

All References

Nickname

301 61125 ’

Search Auto Chain §

| Display v

Options which allow you to run a “genealogical”
3“ search of the parcel and include “parent” or “child”
Forward parcels of the subject parcel. These options are
Mone county-dependent.

Previcus Sub

Checkbox option (yes/no). Includes parcels that may affect the subject parcel.

Checkbox option (yes/no)
Date order, newest to oldest or the reverse.

Checkbox option (yes/no). Includes that parcels various recorded legal
descriptions from newest to oldest.

Checkbox option (yes/no)

Checkbox option (yes/no)

DataTrace
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Order Options

Back to Base

I Plant Beginning b |

Back to B Flant Beginning Controls how far back the starter
ack to Base
Mast Recent e (base) should search.
Second Maost Recent

t=1=1a

Search Auto Chain &

Display v Options which allow you to run a

“genealogical” search of the parcel and

Display include “parent” or “child” parcels of
Search Auto Chain Entire P P

Forward the subject parcel. These options are

Mone county-dependent.
Previocus Sub

Adjoining Lots for Base
IE—_l\’ Sets the whether or not adjoining

lots should be considered in the
starter.

Adjoining Lots for Base

Checkbox option (yes/no). Includes properties that may affect
the subject.

Overlapping Property
Extended Name Checkbox option (yes/no)

Sort Date order, newest to oldest or the reverse.

Checkbox option (yes/no). Includes that parcels various recorded

Consolidated Legal L
& legal descriptions from newest to oldest.

Append Unreleased Encumbrances Checkbox option (yes/no)

Create a Base Automatically create a Starter.
Permit Datedown Checkbox option (yes/no)
Use in Fallout Checkbox option (yes/no)
All References Checkbox option (yes/no)
Nickname Checkbox option (yes/no)
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The following screenshots are not representative of your company’s defaults. These are for example
purposes only. For questions on your company’s settings contact your manager.

Title Services - Subdivided:

User Profile

GLOBAL_SERVICES, 1 nvestigative Options
Global Options

Search Auto Chain

TITLE SERVIC|
Subdivided IDispIay -
Arb
::‘;2?;:‘:'& Crverlapping Property Extended Name
Name Sort
TAX SERVICES IDIdest to Newest- Consolidated Legal
Property Taxes
IMAGING "
SERVICES Order Options v
Imaging Options Back to Base Search Auto Chain Adjoining Lots for Base
Flant Beginning IDispIay - IYes i
Cwverlapping Property Extended Name
Sort
|O|dE5tt{} NE“""“3515. Consclidated Legal Append Unreleased
Encumbrances
D Create 2 Base Permit Datedown Use in Fallout
Title Services - Arb:
User Profile
GLOBAL_SERVICES, &1 nvestigative Options
Global Options -
TITLE SERVICES Search Auto Chain
Subdivided Display
Arb
Sectional
e — Extended Name
Name Sort
TAX SERVICES IDIdest to Newest- Consolidated Legal
Property Taxes
IMAGING =
SERVICES Scder Options [ |

Imaging Options Back to Base
IPIant Eeginning -

Sort

|9|dest to Newest -

I:‘ Create a Base

Search Auta Chain

I Display

Consclidated Legal

Permit Datedown

Extended Name

Append Unreleasead
Encumbrances

Use in Fallout

R e R e R e e B B R B e et e e et i PR DT il

DataTrace
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Title Services - Sectional:

User Profile

Global Gotone | SRS

Global Options -

TITLE SERVICES Search Auto Chain

Subdivided IDispIay -

Arb

2'::2?::!5 Cverlapping Praperty Extandad Name

Name Sort

TAX SERVICES |0|m5t to NEWEt.

Property Taxes

IMAGING Ord. -

SERVICES

Imaging Options Back to Basa Search Auto Chain
Flant Beginning IDispIay -
Crverlapping Property Extended Name
Sort

Title Services -

Append Unreleasead
Encumbrances

IOIdEl to Nemﬁt-

D Create a2 Base Parmit Datedown Use in Fallout

Reference:

User Profile

GLOBAL_SERVICES
Global Options
TITLE SERVICES
Subdivided

Arb

Sectional
Reference

Name

TAX SERVICES
Property Taxes
IMAGING
SERVICES
Imaging Options

Investigative Opts

D All References Extended MName

wiider Dpiions

D All References Extended Name

Permit Datedown Use in Fallout

Title Services - Name:
User Profile
GLOBAL_SERVICES| pame Investigative Options
Global Options
TITLE SERVICES Sort
Subdivided Nickname IOIdEHD N-E'NEt-
Arb
Sectional Name Order Options
Reference
Name
TAX SERVICES Nickname
Property Taxes sort
IMAGING o
SERVICES |0|m5t 1o Newest| v | Append Unraleased

Imaging Options

Encumbrances

I:‘ Create a Base Permit Datedown

Use in Fallout

DataTrace
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Tax Services - Property Tax
User Profile

GLOBAL_SERVICES 1pyestigative Options
Global Options

TITLE SERVICES
Subdivided Improvements
Arb

Sectional Order Options
Reference
Name
TAX SERVICES Permit Datedown
Property Taxes
IMAGING
SERVICES
Imaging Options

Imaging Services:
Usar Profile
GLOBAL_SERVICES

Imaging Options
Global Options —
IMAGING
SERVICES Image Print Options

Imaging Opticons
I:‘ Show Header

|:| Show Footer |

D Include Summary List

Image Print Order
IChmncIGgiDaI .

County Currency:
This feature is also county specific and may not be displayed in all counties.

Profile | Help County Currency

] PRODUCTS
User Profile Flant Currency
County Cumency Tax Currency

Click on either Plant or Tax Currency to review the thru dates for the county.

County Currency

PRODUCTS Pla

Plant Currency LAt L=l s

Tax Currency
Full Through Date: JUNE 16, 2016
Instrument Through Date: JUNE 16, 2016 05:00 PM
Instrument Through: 2016- 421757
Court House: AFRIL 02, 2016
Plat List Through: MAY 04, 2016

DataTrace 13 How To Guide



Tool Bar
The left hand side of the tool bar contains controls for the following:

@ |2 - % -| L -|Sate AZ - |County MARICOPA - |C

1. Home: Returns you to the DTS2 home page and clears the search or document from the
multi-function panel. It does not clear your history panel (see the History Panel
section below for additional information).

2. Print Print, Create PDF, and Create Email all include the following options:

L e . + | State CA = | Courty

- —

These options give you the ability
to print, create pdfs, or create and
email one or several reports with
or without the images (or all
selected items).

Report Group with Requested Images

3. Create PDF Report Group

Report with Requested Images
Report Onby

4. Create Email Al Selected ftems

EETETIT A TITE
Grantor/Grantee

5. & 6. State and Select your state and then your county in which you need to work. Click “GO” to
County Selects change to that county (9, below).
5 Company ~ HGD Bl:anu:el &) County Cumency EAHB Map
1

8. Your company ID Your company’s name and designated abbreviation.

9. & 10.: Go and Cancel After selecting a state and county, click “GO” to switch to that county (or
Cancel to stay in the existing county)

11. County Currency This is county specific. Returns the same information shown in the County
Currency section, above.

12. ARB Map Launches the DataTrace Arb Maps website. Once on the page, select the
state and county you are researching and enter the Arb information to
retrieve the required map.

DataTrace 14 How To Guide




Services Panel

The available services displayed in the services section will vary by county and your company’s
contracted services.

SERVICES

TITLE SERVICES

T) Subdivided To use a service simply click on the service name or, if you like
E) Arb

5]:: 5Ercti.:.na| keyboard shortcuts, use hold down the control key (CTRL) and

8) Title By Address/ Parcel
R) Reference

G) General Name

E) Grantor/Grantee

1) Instrument

the corresponding letter next to the service name.

1) Case

P) Plat List CTRL+S will open the Sectional service form while CTRL+X will
TAX SERVICES .

X) Property Taxes start the Property Tax service.

MISCELLANEOUS SERVICES
0) Datedown

7) Batch Datedown

F) Fallout

H) Batch Imaging

For more information on the individual services, please see the
Z) Completed Searches

O] Display/Maintain Order How to Guides in DataTrace Title University

W) Close/Cancel Order . . .

Q) Display/Maintain Base (http://www.datatracetitle.com/data-trace-university).
HISTORY

Investigative [1:07 PM &6/21 i
P LR
BJ [JFLN 1074.285 (1) (1

Investigative (1:09 PM &6/21°
@ [ L:327 BV Pi5

@ CA, ORANGE, STS (06/21/ 2
Investigative [1:34 PM &6/21°
@ [[]5:8841 LN
Investigative (1:34 PM 6/21|E
- DU:B Y1992 14625919

1|

1| 1] [ 3
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History Panel

The history section of the panel will list all of your search results, grouped by county.

SERVICES

TITLE SERVICES

T) Subdivided

B) Arb

5) Sectional

8) Title By Address/Parcel
R) Reference

G) General Name

E) Grantor/Grantee

1) Instrument

1) Case

P) Plat List

TAX SERVICES

X) Property Taxes
MISCELLANEOUS SERVICES
) Datedown

7) Batch Datedown

F) Fallout

H) Batch Imaging

Z) Completed Searches
O] Display/Maintain Order
W) Close/Cancel Order
Q) Display/Maintain Base

HISTORY

P T

Investigative (1:07 PM &6/21° i
PR - LE
] [JeLn 1074.285 (1) (1

Investigative [(1:09 PM &/21°
o [ Li327 Bi7 PiS

@ CA, ORANGE, STS (06/21/ 21
Investigative [1:34 PM &/21°
@ []s:8841 u
Investigative [(1:34 PM &/21|=
@ [JU:3¥:19582 [:462518

1| 1] [ 3

1|

To return to one of your
previous searches, click
on that search or
document and the item
will be reloaded into
the multi-function
panel.

This panel will be cleared automatically when you end your

session or quit the application.

You can also right click on any of the searches or documents and

delete or print them.

SERVICES

TITLE SERVICES

T) Subdivided

B) Arb

5) Sectional

3) Title By Address/Parcel
R) Reference

G) General Name

E) Grantor/Grantee

I} Instrument

1) Case

B) Blat List

TAX SERVICES

X) Property Taxes
MISCELLANEOUS SERVICES
0} Datedown

7] Batch Datedown

F) Fallout

H) Batch Imaging

Z) Completed Searches
) Display/Maintain Order
W) Close/Cancel Order
) Display/Maintain Base

HISTORY

T P

-
Investigative [1:07 PM &6/21°
a iy M
By [JFLN 1074.285 (1) (1

Investigative [1:09 PM &/21

.ﬁ I A& Print Report

Invells I& Print All Selected ltems
@ [

Inve

@ [ %Delete Report and Images

¥ Uncheck Al Selected ltems

i p— @ Delete All Reports and Images

DataTrace
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Multi-Function Panel
The main area of DTS2 is used to provide various forms for entering search criteria, displaying search
results, system updates, and training information, as shown below.

File View Profile

o8-8 -

Help
~ | State AZ

-+ | County MOHAVE

Cancel

@ Courty Cumency [E] ARB Map

SERVICES

TITLE SERVICES

T) Subdivided

B) Arb

5) Sectional

8) Title By Address/Parcel
R) Reference

G) General Name

E) Grantor/Grantee

I) Instrument

1) Case

P Plat List

TAX SERVICES

X) Property Taxes
MISCELLANEOQUS SERVICES
O} Datedown

7] Batch Datedown

F) Fallout

H) Batch Imaging

Z) Completed Searches
0) Display/Maintain Order
W) Close/Cancel Order
Q) Display/Maintain Base

HISTORY

N r p
Investigative (1:07 RM &/21°

Phone: 800.221.2056

Email: Clier

Elog

Data , Trace’

WELCOME TO DATA TRACE

DATA TRACE EXPANDS FEDERAL BANKRUPTCY
DATA

View

4 @ [ N:SHIROMA File
B [(JFLn 10742

Profile

Help

-

4 I

@ | 2% -4~ |Sae AZ ~ [County MARICOPA - | Company = || 1Go ()Cancel ) County Curency [EARB Map
Investigative (1:09
@ [L:327 B:7 p:5 || | LSERMICES -DATA TRACE, ANE, NATL MARICOF *
@CA, ORANGE, STS (of  THTLE SERVICES = | [0612112016 10:47Am w470 INVESTIGATIVE SEARCH RESULTS PAGI|=
Investigative (1:34 B) Arb b
@ []5:8841 LAMPS|  5) Sectional PLANT THROUGH
Investigative (1:34 ff 31 THe By Address/Parcel JUNE 16, 2016 (Full) INSTRUMENT: 2016 - 421757 JUNE 16, 2016 05:00PM
H H o
@[3 Y:1992 19 G) General Name COURT HOUSE: APRIL 02, 2016
E) Grantor/Grantee
I) Instrument SEARCH PARAMETERS
1) Case
?}&";E ;iztICES ADDRESS: it 5l w
X) Property Taxes CROSS REFERENCE SUCCESSFUL
BUSINESS SERVICES
¥) Corporate/LB/LLC [LoT HI LOT BLOCK PLAT SUB LOT HI SUB LO1
N) MNotary Public 107 30821
HISTORY SUBDIVISION: WARNER RANCH MANOR UNIT I
@ CA, TUOLUMNE, 75 (06/21/ » | SEARCH: FROM 00/00/0000  THROUGH 99/99/9999
Invastigative (10:18 AM &/2 || DISPLAY AUTO CHAIN; OVERLAPPING PROPERTY
@ []2:002-153-005 EXTENDED NAMES
$ [(IXREF UNSUCCESSFUL| || MATCHED CROSS REFERENCE LEGAL
Investigative (10:159 AM 6/2| _ PARAMETER ENTERED:
@ Y:2016 1:00005988 i
Investigative (10:21 AM 6/2 LOT HI LOT BLOCK PLAT SUB LOT HI SUB LO1
@ [(]¥:2016 1:00005338 107 308-1
Investigative (10:22 AM &/2 = AUTO CHAIN :
@ [B:002-153-005 ’
Investigative (10:23 AM 6/2 0912/1985 PLAT 277-29 BLOCK LoT SUBLOT
O
@ [JXREF UNSUCCESSFUL 0000 CREATED ARB 30161125
Investigative (10:26 AM &/2
& [ XREF UNSUCCESSFUL []  03/031987 ARB 301 61125
Investigative (10:31 AM 6/2 1987 - 127520 0000 CREATED PLAT 308-21
@ [ IXREF UNSUCCESSFUL [] 0300311987 PLAT 277-29 BLOCK LOTG sUBLOT
@ AZ, MARICOPA, STS (06/21
Investigative (10:45 AM 6/2 ~ 1987 - 127520 0000 CREATED PLAT 308-21 -
« T 3 < T ] r
[ Preview) Show All][ Summary [ Add +]( Save [ Request Images Quick Name|[Quick Order| |5 <= [PAGES1-60f 6 ==
| 1D: w470 |

DataTrace
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Button Bar and Status Bar

The bottom of the DTS2 application window will change depending upon what service you ran, providing
additional functionality and allowing you to jump to Tax, Title, preview documents, or navigate through
pages.

These features will be explained in the Services How To Guides as required.
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Getting Help

There are several ways to get assistance in DTS2.

The Client Services phone number and email link are always at the top of the DTS2 home page:

% Data Trace System 2.0 DATA TRACE; STS [MARICOPA, AY] [DTS]

File View Profile Help
& | - | - | - | State AZ ~ |County MARICOPA * |Company DATA TRACE; 5TS

SERVICES

TITLE SERVICES

T) Subdivided

B) Arb

5) Sectional

8) Title By Address/Parcel

Email: Client Services o 2

» Phone: 300.221. 2056
-

Plant Coverage information and Blog
topics are included at the top right hand
corner of the application window:

T e e e e e e e e e e et e PP o P N

Phone: 800.221.2056 Email: Client Services

} FEATURED DATA
Data )/ Trace’ TRACE UNIVERSITY
COURSES

WELCOME TO DATA TRACE

I

e A A

» County Specifics for Placer

California

P

DATA TRACE EXPANDS FEDERAL BANKRUPTCY _
DATA R —

» DTS2 County Specifics El

Dorado California
* How to Read a Title Chain

+ Tax Services - Southern

DATA TRACE EXPANDS FEDERAL BANKRUPTCY DATA California property Taxes
JUNE 2016 + Broad Search Functionality

» County Specifics for Hawaii
Read More About Data Trace EXPANDS Federal Bankruptcy Data
« Title Integrated Property

Service (TIPS) pu

< i | B |-

A A YA e P AP A AP P A A A

Finally, the multi-function panel includes the latest updates as well as links to elearning content.
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